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1.  Introduction to Online Video 
 

They say a picture is worth a thousand words. Well, if that is true, 
then online video has the potential to be priceless. In what other 
medium can you combine words (spoken or on-screen text) with 
arresting and eye-catching imagery / footage – and all for a next to 
nothing in cost? 
 
Popular online video websites like Youtube, Vimeo or Veoh, can 
provide you with the perfect platform from which to paint your 
communication pictures for the world.  
 
How Popular? 
 
It is estimated that an incredible 20 hours of video is uploaded to 
Youtube (the most visited online video website) every single minute. 
These videos consist of all sorts of content: from the comedic to the 
crass to the more carefully thought out, Youtube has got it all.  
 
Some people see that as a problem: they imagine online video 
websites to be the preserve of time-wasters and slackers, but that is 
a misconception. The power of online video is not just that you can 
create a clever clip, upload it and then promptly forget about it – 
rather, it is that you can then embed your video in your various social 
media profiles, on your website, and in promotional emails to your 
target audience. A good online video can illuminate a campaign, 
inspire a movement and serve as a technologically astute calling 
card for your organisation’s relevance and online growth. 
 
The aim of this guide is to show you how to achieve this. 
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2.  Getting Started (things to consider, options)  
 

You’ve got the will, the inspiration and the ideas – all you’re missing 
is the right equipment. Below you’ll find a brief description, along with 
some limited example of popular / bestselling products, of the 
various types of equipment you can use to shoot your video project 
on. 

 
2.1  Camcorders  
 
Short of buying an ultra-expensive cine-camera, camcorders are 
the most accessible way of shooting your online videos. There 
are so many models, covering all price ranges, to choose from 
that it may get a bit dizzying deciding which one is right for you.  
 

We outline the main options below: 
 
“Shoot and Share” Camcorders – cheap and cheerful 
and capable of shooting high quality video, this is the 
latest category of camcorders to hit the market. With 
prices starting at around €100, these pocket-sized 
camcorders feature an internal memory; a basic zoom 

function; and very often have a handy flip out USB arm (allowing 
you to plug the camcorder directly into your computer). 
 

 Do choose this camcorder if you want an inexpensive and 
highly portable camcorder for video on the go. 

 Don’t choose it if you want the high-powered tools and 
features offered by the higher-end camcorders (see below). 

 Top-rated / best-sellers on Amazon.co.uk: 
o Creative Vado HD 4GB 2nd High Definition Pocket 

Camcorder – get more info 
o Flip Video Ultra Camcorder 2nd Generation With 

4GB Memory – get more info 
o Kodak Zi8 HD Pocket Video Camera – get more info 

 
Flash Memory Camcorders – working on the same internal 
memory principal as the “shoot and share” 
camcorder, higher-end flash memory 
camcorders usually come with a wide range of 
features, such as: automatic face detection; 
image stabilization; and high-definition 
recording. Again, like the “shoot and share” 
model, there are no moving parts, tapes or 
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DVDs required for these camcorders. In addition, the internal 
memory is usually expandable.  
 

 Do choose this camcorder if you want the best of both 
worlds: a self-contained camcorder with lots of video tricks 
up its sleeve. 

 Don’t choose it if you also want to be able to record directly 
to DVD. 

 Top-rated / best-sellers on Amazon.co.uk: 
o Panasonic TM60 Full HD Camcorder With 16GB 

Inbuilt Flash, Wide Angle Lens – get more info 
o Samsung R10 Full HD Flash Camcorder (5x Optical, 

2.7 inch LCD) – get more info 
o Panasonic SDR-S15 Flash Memory Camcorder With 

SD Card Slot – get more info 
 
Hard Drive Camcorders – an increasingly popular option, hard 
drive camcorders record all footage directly to the cameras built-
in hard drive. As anyone familiar with a computer hard drive is 
aware, this means that there is potential to store hours and hours 
of video on the camera. In addition to the usual high-end features 
and tools, you can also expect options for choosing your video 
quality (lower quality provides you with more shooting time etc.) 
 

 Do choose this camcorder if you think you will be shooting 
a lot of video (beyond the limited memory capacity of 
internal flash camcorders). 

 Don‘t choose it if you want a quick and simple shooting 
solution. 

 Top-rated / best-sellers on Amazon.co.uk: 
o Panasonic SDR-S50 Camcorder SD Card, Wide 

Angle Lens – get more info 
o Sony DCRSR58EX Handycam Camcorder With 

Built-In 80GB HDD – get more info 
o Sony DCRSR37ES Handycam Camcorder With 

Built-In 60GB HDD – get more info 
 
DVD and MiniDV Camcorders – stocked with varying degrees of 
features and tools (zoom, face detection etc), both of these 
camcorder types require you to record your video directly onto 
DVD / mini videotape. Most newer models permit the uploading of 
content to computers, but the process can be time consuming. 
 

 Do choose either of these camcorder options if you want to 
have a recording that you can play back on suitable 
TV/video equipment.  
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 Don’t choose either option if you are adamant about 
uploading your video to the internet. 

 Top-rated / best-sellers on Amazon.co.uk: 
o Sony DCR-DVD106 Handycam DVD Camcorder 

With 2.5'' LCD Screen – get more info 
o Canon DC95 Digital DVD Camcorder (2.7" 

Widescreen Colour LCD) – get more info 
o Sony DCR-HC45 Handycam Mini Dv Camcorder with 

2.5'' LCD screen – get more info 
 
         2.2  Digital Cameras 

 
Another excellent option for recording video is to use a digital 

camera. Most digital cameras come equipped with 
some sort of basic video shooting option as standard 
nowadays. Newer models may also a high-definition 
shooting mode, which will only serve to further 
enhance your video project. Most digital cameras also 

have expandable memory cards, so that you can increase the 
amount of video footage that you shoot.  
 
Digital cameras also usually have a good zoom option, although 
you might want to ensure that a particular model is capable of 
zooming while recording video before purchasing it. A good tripod 
can also go a long way in enhancing the quality of your video 
shoot. 
 
One of the often overlooked advantages of shooting video with a 
digital SLR camera is that, once you’ve wrapped your shooting, 
you can then click off a bunch of still photos on the same device, 
which you could then use to compliment or accompany your video 
campaign. 
 

 Do use this option if you want a multi-tasking piece of 
equipment that is easy to operate and connect to your 
computer. 

 Don’t use it if you require the higher-end camcorders with 
all their bells and whistles. 

 Top-rated / best-sellers on Amazon.co.uk: 
o Canon EOS 500D Digital SLR Camera with HD video 

– get more info 
o Panasonic Lumix TZ7 Digital Camera with HD video 

– get more info 
o Canon PowerShot SX210 IS Digital Camera with HD 

video and stero sound – get more info 
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          2.3  Mobile Phones 

 
Mobile phones are certainly not the ideal way to shoot video but, 
as most of us usually have one to hand at all times, and as the 
quality of video they are capable of shooting is constantly 
improving, you should definitely keep them in mind.  
 
As with all video footage, you need to consider the possibilities 
and the drawbacks of the technology you are employing. For 
example, can your mobile phone record sound as well as video? 
Does it look too grainy when expanded to the size required for an 
online video? How much footage is your phone capable of 
recording? How do you then transfer it to your computer / the 
internet? 
 
Preparation and understanding of what your equipment is capable 
of is of paramount importance. But, at least if it doesn’t work out, 
you will still be able to call a taxi to take you home! 
 

 Do use this video recording device if you’ve got a really 
high-tech James Bond type phone and if you’ve really got 
no other option. 

 Don’t use it if you’ve got a Miami-Vice style 1980’s phone 
and if you require quality video. 

 Compare mobile phone models here: 
o Vodafone - http://www.vodafone.ie/ 
o O2 - http://www.o2online.ie/ 
o Carphone Warehouse - 

http://www.carphonewarehouse.ie 
 
 

2.4  Webcams 
 
Another video recording option, of limited but definite use, is to 
record your video using a webcam. The most obvious limitation a 
webcam offers is that you need to be sitting at a computer in 
order for it to work.  
 
Where a webcam comes into its own however, is when you are 
unable (due to distance or other reasons) travel to interview 
someone of interest. With a little bit of planning it is possible to set 
up a video conference with this person instead. You can instruct 
them in how they can set up their webcam to record themselves 
answering your questions (possibly over the phone). You can 
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even set up a split screen, which can be recorded, between the 
two of you. Another dinky attraction of using a webcam is that you 
can record your webcam broadcasts directly to Youtube, with no 
need for editing programmes at all (login to Youtube – click 
Upload and choose the Record from webcam option). 
 

 Do use a webcam if you are unable to travel to interview a 
subject. 

 Don’t use one this option if you need a flexible and portable 
video recording device. 

 Top-rated / best-sellers on Amazon.co.uk: 
o Microsoft LifeCam VX-1000 Webcam – get more info 
o Kinobo USB Webcam 6.0 Megapixels with Metal 

Stand + Mic & LED lights – get more info 
o TeckNet New Webcam Camera, 5 MegaPixel, 5G 

Lens, Built-in microphone, Built-in LED lights – get 
more info 

 
 
2.5  Or No Video at All! 
 
One of the most effective ways of putting together an online video 
is to create a photo montage (perhaps set to music or with 
narration). No interviews, or footage required – just a carefully 
arranged series of still photos. 
 
The advantage of this approach is that, first of all, you obviously 
don’t need to go out and buy a camcorder on which to shoot your 
video. Also, if you take your time and do it right, you may well end 
up creating a video that tells a more compelling story than a 
dozen interviews could ever do.  
 
One method of putting a photo montage video together is to use 
either Windows Movie Maker (PC) or iMovies (Mac). Just like 
when making a video from recorded footage, firstly you import 
your content (photos) into the movie editing suite and then begin 
the cutting process. See the Create Your Masterpiece section 
below for further instructions. 
 
Alternatively, you can use one of the many free video slideshow 
software packages that are available online. See the Appendix I. 
Free Online Video Resources below for suggestions. 
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3.  Be a Spielberg in 10 Easy Steps (tips for shooting 
good video) 
 
Whether you've purchased a high-end HD camcorder or perhaps 
a more modest digital device, there are some universal standards 
when it comes to shooting video. Try to keep at least some of 
these in mind before you hit the record button: 
 
1. Get to know your equipment... 
 
When you get your shiny new camcorder/camera, chances are 
that you're going to want to rush out and immediately start making 
your movie. Tempting as it may be, the smart move though is to 
take the time to read through the instructions before doing 
anything else. You don't, for example, want to be about to 
interview someone only to realise that you actually have no idea 
how to turn on your camera!  
 
Take the time to learn the ropes and become familiar with your 
equipment: it may just save you from some embarrassing 
situations further down the road. (It might also be a good idea to 
test out your skills on willing colleagues and friends.)  

 
Finally, don't make the most basic rookie mistake of them all - 
don't forget to charge your battery before leaving the office! 
 
2. Steady your shot with a tripod... 
 
A shaky video doesn't just look amateurish and unpleasant on the 
eye but it is also likely to produce in the viewer a distinct feeling of 
sea-sickness! There are some schools of thought that swear by 
the shaky, hand-held camera look, due to the apparent realism it 
provides. However, as the objective here is to produce a 
watchable online video that gets your message across in the most 
effective way possible, this is not a good option for the casual 
video maker.  
 
Therefore, to steady your hand and make your interviews look as 
professional as possible, a tripod is strongly recommended. If you 
don't have a tripod to hand however, you could try placing your 
camcorder/camera on a flat surface - making sure to check the 
subject is centred appropriately in the frame - and then hitting the 
record button. 
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3. Search for that unique angle... 
 

When you've made a couple of videos already, you may want to 
branch out into something a bit more adventurous. A good way to 
achieve a fresh feel to your videos is to shoot from a different, 
less predictable angle. For example, you could try a high angle 
shot when filming a large gathering/event (to give it a panoramic 
aspect) – yes, a step ladder might just give your video that extra 
edge it's been looking for!  
 
Try and find a backdrop that has something to do with your 
subject. For example, if you are interviewing a football coach 
about his work with young people, film the introduction/interview 
with footballers playing in the background. So many amateur 
videos contain monotonous shots of interviewees with a blank 
wall behind them – the challenge is to bring the subject to life with 
colourful shots of activity. Even a shot of someone drinking coffee 
in a cafe is livelier and more dynamic than a dull office setting! 
 
You should also familiarise yourself with the ‘Rule of Thirds’ - this 
is a concept in video production in which the frame is divided into 
an imaginary grid of nine squares and then the most important 
elements (e.g. faces) are placed where these lines intersect.  
 
4. Establish a professional look... 
 
Establishing shots are a good way to achieve a professional feel 
for your video. Establishing shots are where you shoot some 
footage, up to 20 seconds worth, of an interesting 
view/event/building over which you can apply some voice-over 
during the editing process. This is a very good way of introducing 
an interviewee (perhaps with an establishing shot of the building 
where the interviewee works or of them speaking at a conference) 
to your viewers.  
 
Establishing shots typically are taken from a distance or in close-
up (to distinguish them from the standard interview shot). 
 
5. Respect the power of zoom... 
 
Chances are good that your equipment comes equipped with a 
zoom function and you shouldn't be afraid to use it. But, as we all 
know, with great power comes great responsibility (or great 
disaster!) No viewer wants to be subjected to a video with a 
zoom-happy director on duty - so remember to use that great 
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power sparingly, if at all. And when you do choose to zoom in on 
a subject/interviewee do so carefully and slowly.  
 
The same goes for panning shots - avoid using them to excess 
(unless you’re recording a tennis match of course!)  
 
Used sparingly, both of these techniques can lend your video a 
truly professional look. Now, are you ready for your close up? 
 
6. Conducting a successful interview... 
 
Put your interviewee at ease and keep things as informal as 
possible - this isn't The Frontline on RTE (we can’t all be as 
charismatic as Pat Kenny after all). In order to prevent your 
interviewee from rambling endlessly into camera, give them a firm 
idea before you start recording of what the focus of the interview 
will be and approximately how long it will last.  
 
When it comes to the more technical aspects of the interview 
setup, remember the ‘Rule of Thirds’ concept (from above) when 
positioning your camcorder/camera and remember to leave a little 
headroom at all times. When shooting you should keep an eye on 
your LCD screen to ensure that the shot is framed well, but 
maintain as much eye contact with your interviewee as possible. 
 
Remain completely silent during the interview (nod rather than 
verbally agreeing). Use body language to indicate when you are 
about to ask a question so that the interviewee knows to stop 
speaking. It’s important to make sure that your interviewee has 
completely stopped speaking before you ask your question - this 
will assist you later in the editing process, when you may wish to 
rearrange the order of questions.  
 
7. Put some light on the subject... 
 
How sad it would be if you were to shoot a nice little bit of video 
only to later realise that, actually, it's unusable due to the poor 
lighting throughout. Nobody expects you haul a great big 
Hollywood-style lighting system around with you, but keep a good 
eye on where your light sources are located. Never ask your 
interviewee to sit/stand in front of a window or with the sun 
directly behind, as they will then appear in silhouette.  
 
Ideally, the source of light will be shining directly onto the 
interviewee (without overwhelming them). And take heed of the 
glare the sun can cause if shining directly onto your lens. 
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8. Sorting your sound out... 
 
Anyone familiar with a shooting video on almost any type of 
device cannot have failed to notice how even the slightest breeze 
can sound like an approaching tornado when played back later. 
So try to avoid shooting in the wind!  
 
Whether you're using a handheld or a built-in microphone, make 
sure to position it close enough to obtain a clear recording but not 
so close as to inappropriately intrude on your interviewee's 
personal space.  
 
9. Take advantage of your schedule... 
 
Once you have a clear concept of the type of video you wish to 
make, you may decide that you need to interview several people 
for it. Rather than gallivanting around the country, visiting each 
one individually (and clocking up travel costs in the process), try 
to pinpoint a day on which you could interview several relevant 
figures at once.  
 
For example, if you've got a conference coming up soon, prepare 
a few standard questions and grab your camcorder / digital 
camera and conduct as many interviews as you can. You will then 
be spoilt for choice when you come to the editing process. 
 
10. Enjoy yourself...  
 
Don't get so caught up in the process that you make it a misery 
for you and the interviewee! Trying to have fun while you shoot 
your video is not only good for morale but it is also more likely to 
show in the final product (who wants to watch a video with some 
sourpuss spitting out answers at the camera?)  
 
Strive to be creative and don't be afraid to try new things - they 
might not all work but they're surely worth a try. 

 
Remember... 
 
There are no certainties when it comes to shooting video. However, 
adhering to at least some of the basic tips and guidelines suggested 
above should help you on your way to your next glorious digital 
creation. 
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4.  Importing Your Video to Your PC/MAC 

 
Your options for connecting your camcorder/camera to your pc 
will vary depending on the equipment you are using. For instance, 
some camcorders will require a specific type cable (consult your 
manual) to connect to your PC while others connect via a USB 
cable.  
 
When you are sure that you have the correct wires/connections 
available, then follow these guidelines: 
 
PC 
 
Step 1 - Once you have the connected your camcorder / digital 
camera to your PC using the appropriate cable, switch your 
recording device on. This should automatically launch the 
programme designated for importing video to your PC (which may 
well come included with your camcorder / digital camera). If this 
does not happen, launch the programme manually instead and 
follow the on-screen instructions. 

 
Step 2 - Another more direct way of importing video to your PC is 
to use Windows Movie Maker (WMM): to do this open WMM and 
click Import from digital video camera to begin transfer. On-
screen instructions will then guide you through the process. Using 
WMM to import your video to your PC is the best option if you are 
ready to start editing your video immediately. Note: if you are 
using a pre-Windows 7 version of Windows Movie Maker, you 
may experience difficulty importing video from newer camcorder 
models (which use MP4 files). See Appendix I: Online Video 
Resources for video conversion software link, which can be used 
to convert MP4 files to WMV/AVI for use in Windows Movie 
Maker.  

 
Step 3 - Once you are sure that your video has been successfully 
imported, switch off your camcorder / digital camera and 
disconnect it from your PC.  

 
Mac 
 
Connect your camera to your computer’s USB or Firewire port 
(use the cable supplied with your camera). iMovie should start 
automatically and prompt you to import the contents of your 
camera.  
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If not, open iMovie and select File > Import from Camera to 
capture footage from your camera, or File > Import Movies to 
import existing video clips from a camera, disk drive or other 
device.  
 
You are now ready to begin the editing process. Please refer to 
your devices full instructions for more detailed guidelines. 
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5.  Creating Your Masterpiece (movie editing software) 
 

Okay, so you’ve successfully transferred your magnum opus from 
your camcorder / digital camera to your computer. But, lets’ say 
you now want to edit it, perhaps to remove controversial 
statements from the interviewee (“the money was just resting in 
my account”), then there is a wide range of editing software 
solutions to consider For now however, we’re going to focus on 
two specific programmes: Windows Movie Maker (for PC users) 
and iMovie (for Mac users). 
 
Please also keep in mind that there are many ways to both skin a 
cat and to edit a video. The guidelines below are offered as a 
basic outline for editing in Windows Movie Maker and iMovie. You 
can find many more free instructional videos and articles, 
covering more advanced / alternative editing techniques, across 
the internet. See Appendix I below for additional resources. 
 
Windows Movie Maker (PC)  
 
Important: this guide was created for users of pre-Windows 7 
versions of Windows Movie Maker. It is therefore only suitable for 
people using Windows Vista and earlier versions of Windows. 
Windows 7 users can download the appropriate version of 
Windows Movie Maker by clicking here. 

 
 

5.1  Basic Edits 
 
Windows Movie Maker (WMM) is an excellent movie editing suite 
that comes as standard with most Windows-based PCs. To open 
it on your PC, go to Start > All Programs > Windows Movie 
Maker. 
 
Step 1 – Importing video to Windows Movie Maker. If you 
have not transferred your video directly to WMM (see relevant 
section above), you will now need to import your video files. To do 
this, click Import Media (Fig. 5.1.1) and double click on the 
relevant video files to import. To choose several files at once, 
hold down the CTRL key and click the relevant files and then click 
Import. Once you have imported your files, it might be a good 
idea to rename them with titles relevant to their content. This will 
help you to keep track of which clip is which during the editing 
process. To rename a file, right-click on it and then click Rename. 
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(Fig 5.1.1 – Importing video to WMM) 
 

 
Step 2 – Splitting Clips. Those bright folks over at Microsoft 
have set WMM up to automatically detect scene breaks in your 
video (the points at which you stopped recording a scene and 
then later began recording another scene). WMM will split your 
video up into clips accordingly. The only slight problem with that is 
that you will sometimes end up with a clip that contains more than 
one scene (nobody’s perfect Mr Gates!) In such instances it is 
advisable that you split the clip yourself and then rename the 
resulting two clips accordingly. 
 
To do this, drag the playhead to the appropriate frame and then 
click the Split button (Fig 5.1.2). Alternatively you can use a 
keyboard shortcut to split clips: CTRL + L. 
 

 
(Fig 5.1.2 – splitting clips) 
 
Handy tip: if you want to reverse a split you made, just select the 
two relevant clips and click the Undo button or CTRL & M. 
 
You can use this same tool to remove irrelevant frames from the 
beginning or end of clips. Again, just drag your playhead to the 
relevant point in the video and hit the Split button to isolate these 
unnecessary frames from the section of video you want to keep. 
To then delete the unnecessary frames, right-click on the relevant 
file and click Remove. 
 
Step 3 – Setting up your Storyboard. Say hello to your little 
storyboard – it’s going to be your special friend! The storyboard is 
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where you can weave your tale together and apply all sorts of 
exciting titles and animations.  
 
To start, you’ll need to drag your clips down to the storyboard (Fig 
5.1.3). This couldn’t be easier – just use your mouse to literally 
drag them down to the storyboard. You can also drag the various 
clips around the storyboard, to put them in your preferred order. 
 

 
(Fig 5.1.3 – setting up storyboard) 
 
 
Step 4 – Timeline Editing. To get down into the real nitty-gritty of 
editing, you’ll need to switch to the Timeline view (select View > 
Timeline).  
 
Position your cursor at the beginning or end of the clip you want 
to edit. A red arrow will appear inviting you to ‘click and drag to 
trim the clip’ (Fig 5.1.4). Drag the arrow to the desired point along 
the offending clip and release – the unwanted part of the clip has 
now been deleted! 
 

 
(Fig 5.1.4 – editing timelines) 
 
Chop and change as many clips as you think you need to (without 
going overboard). Cleaning scenes up and removing excess 
footage will help to give your online video that professional 
appeal. 
 
Important: Youtube videos cannot be longer than 10 minutes in 
length. If your finished video exceeds this limit, consider splitting it 
into appropriately sized clips using the methods outlined above. 
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(You may also want to insert new beginning / end titles into 
relevant sections). 
 
 
5.2  Adding Music  
 
You can really jazz things up by adding a little music, or possibly 
narration, to your video. You could try fading some music in at the 
beginning of the video and then again at the end – and, if you’re 
feeling adventurous, you could even fade the music up/down 
between interviews/scenes. 
 
Step 1 - Click Import Media and then browse to the relevant 
music file and double-click. For multiple files, hold down CTRL on 
your keyboard, highlight several files at once and then click 
Import.  
Step 2 - Next, you’ll need to drag your music files down into the 
timeline. This will place it into the Audio/Music track of the 
timeline. 
 
You will then be able to split and drag the music clip in much the 
same way as you have already done for the video clips.  
 
Note: to apply edits to the Audio/Music track you will have to 
make sure your select that track first by clicking on it with your 
mouse. 
 
Super Perky Audio Tips: 
 

 To adjust your volume, right-click and select Volume: then 
drag the volume bar to the desired setting and click OK.  

 Tempting as it may be, remember: you can’t use 
copyrighted music in your video if you intend to put it 
online. Youtube is constantly searching new videos for 
copyrighted material – when found, the video is 
immediately removed / censored. See Appendix 1 below 
for copyright free music solutions. 

 You can fade your music in at the beginning and out at the 
end by right-clicking on the Audio/Music track (Fig 5.2.1) 
and selecting either Fade In or Fade Out. 
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(Fig 5.2.1 – fading audio in/out) 
 
 
5.3  Adding Narration  
 
Adding a voice over to your video can lend it a far more personal 
touch, plus it is a good way of providing context and additional 
information for the on-screen images. 
 
One additional piece of equipment you’ll need to have to hand is 
a microphone (some PCs / laptops have built-in microphones, 
although their sound quality varies wildly). 
 
Step 1 - Once you’ve got your microphone set up click Tools > 
Narrate Timeline.  
 
You can use the Input level tool (Fig 5.3.1) to test how well your 
microphone is picking up your voice. Speak into it and take a look 
at the Input level gauge – ideally this should be hovering in the 
upper green area, but below the red alert zone. You can adjust 
the input level by dragging the input volume up or down until you 
get the desired results. 
 

 
(Fig 5.3.1 – adjusting input level) 
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Step 2 - When you’re satisfied with the microphone levels and 
you know approximately what it is that you are going to say, click 
the Start Narration button and let them have it!  
 
Step 3 - Click Stop Narration to end your voice over. Then type 
an appropriate name into the File name box that pops up and 
then click Save followed by Close. 
 
Your narration will now be automatically imported into your 
timeline at the appropriate starting point. 

 
 
5.4  Adding Titles or Credits  
 
By now your video should really be beginning to cook! But, to give 
it that extra twist of cinematic class, perhaps you’d like to add 
some titles or credits to it? Here’s how it’s done... 
 
Step 1 – Click on Tools > Titles and Credits to open the Titles 
interface (Fig 5.4.1). 

 
Here you will be presented with four options for where you can 
place your titles/credits: 
 

i. Title at the beginning – this is your chance to insert a title 
that succinctly introduces the viewer to the rest of the 
video. 

ii. Title before the selected clip – click first on a specific clip 
within the timeline and then choose this option if you want 
to place an explanatory title directly before it. 

iii. Title on the selected clip – as above, except the title goes 
on top of the selected clip (so the video and title display at 
the same time). 

iv. Credits at the end – this is a good place in which to insert 
your website address or contact details. 
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(Fig 5.4.1 – add titles) 
 

Keep in mind that, once you create a title using any of these 
options, you can still manually drag and drop it anywhere along 
the timeline that you like. 
 
Step 2 – Once you have chosen one of the four options above, 
you will then need to enter the text for your title / credits (Fig 
5.4.2).  
 

 
(Fig 5.4.2 – title text) 
 
To make your video as dynamic as possible, you can also try 
playing around with different titles animations. Available 
animations include a spinning newspaper and a scrolling Star 
Wars type font effect. Click Change the title animation (Fig 
5.4.2) to check out these options.  
 
You can also experiment with the titles text font and colour until 
you achieve the result you’re looking for. To do this, click Change 
the text font and color (Fig 5.4.2). 
 
When you are finished creating your title or credits, click Add 
Title to automatically insert it into your video. 
 

 
5.5  Saving Your Video 
 
So, you’ve created your masterpiece and you’re now eager to 
upload it to the internet and share it with the world. But hold your 
horses for just a few minutes more – first we have to save the 
video. 
 
Step 1 – go to File and click Publish Movie to open the movie 
publishing wizard. 
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Step 2 – Highlight the This Computer option and click Next. 
 
Step 3 – Give your video a name, select where you want to 
publish it to and then click Next. 
 
Step 4 – As a beginner it’s wise to choose the Best quality for 
playback on my computer option (you can move on to more 
advanced settings as you learn more). This will save your video 
as a WMV file, which is compatible for Youtube. Click Next. 
 
Step 5 – Finally, click Publish. Windows Movie Maker will now 
finalise your video (this make take several minutes, depending on 
the size of your project). 

 
 

iMovie (Mac) 
These instructions are for iMovie ’09 of higher. You can access a 
free iMovie ’08 tutorial here: 
http://www.apple.com/findouthow/movies/imovie08.html 
 
5.6  Basic Edits 

 
Let’s begin by finding our way around iMovie 09: 
 

 
(Fig 5.6.1 – iMovie layout) 
 
1. Project Library – all the videos you have edited 
2. iMovie Project – this is where you will put your video together 
3. Monitor Window - views clips or your preview your video 
4. Play Project - can play selected movie project either in viewer 
or full screen 
5. New Project - click here to start a new movie project 
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6. Frame Adjustment - zoom in and out to get a closer view of 
your project 
7. Import - where you import footage from your camera 
8. View Flip Switch - rearranges your screen by swapping the 
project and event windows 
9.Thumbnail Size - adjusts size of thumbnails used in iMovie 
10. Event library - where all imported but unedited videos (raw 
footage) appears 
11. Add selection - allows you to add clips from an event to your 
project 
12. Favourites tab - allows you to select favourite clips, or parts 
of clips, or just remove clips from your project 
13. Options tab - this is where you can record a voiceover, crop 
images, adjust audio, or adjust video 
14. Turns on/off Audio Skimmer  
15. Edit browsers - add music, titles, photos, and transitions 
between clips.  
and animations. 
16. Event Window - shows all events (raw source video) that can 
be used for your project. 
 
Panicking? Don’t, we will only be using some of the basic 
features for our video.   
 
Your imported video should appear as an “event” in the event 
library window (10). If not, click on “last import” in the event library 
window (10). The raw unedited footage is known as an event. 
Now you may want to trim some of the excess footage from the 
beginning, middle or end of your video, add titles and a voiceover 
or music. You wont’ be editing the original footage (event), 
instead we will copy the pieces of the event we want to use to a 
new project, which we will  then edit. That way you will always 
preserve the original footage.  

  
Step 1- Create a new project: Begin by creating a new “project” 
(select File > New Project). At this point you will be asked to 
name your movie and to select the screen format - select 4:3 
Standard (suitable for Youtube videos).  

 
Step 2 – Add clips to your project. Chances are good that you 
only want certain bits from the event. We begin by selecting the 
bits we want and transferring them to the project window (2). To 
select the part you want, click once on the point where you want 
your clip to start (16). A yellow box appears (fig 5.6.3). Drag the 
end of the box to the point you want your clip to end. Click on the 
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add section to project button (11), or drag the clip to the project 
window (2).  
 

 
(Fig 5.6.2 – adding clips) 
 
Tip Time: It is a good idea to split your video into several clips – 
think of each clip as a different scene in a movie. By adding 
transitions (like a fade-in) between clips you can improve the flow 
between scenes.  
 
Step 3 – Cropping unwanted footage from your project. Once 
the clips are in the project window you can cut away any 
remaining pieces of unwanted video. Drag the Frame Adjustment 
Slider (6) to get a closer look. Click on the clip to select a point 
and drag the yellow box to select the part you want to remove 
from the clip. Click the “remove” button (X) in the favourites tab 
(12). 
 
Hey presto, that’s it. Take a bow - you’re a regular Steve Jobs! 

 
 

5.7  Adding Music  
 
Adding music to your existing video in iMovies is not terribly 
different to the process of adding audio to Windows Movie Maker 
(a statement sure to cause upset in IT geek circles).  
 
Step 1 – Click on the point in the clip you want to insert the 
music. Then click the Music button (Fig. 5.7.1) in the edit 
browsers menu (15). Browse to your iTunes library and pinpoint a 
suitably rocking (and copyright free) tune. Then select the track or 
drag it to your project. You should now see the song/audio placed 
at the appropriate point along your timeline. 
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(Fig 5.7.1 – music button) 
 
Step 2 – Adjust the length of the tune by dragging the edges of it 
inwards (you might need to scroll to reach the end of the song). 
 
More Superbly Perky Audio Tips: 
 

 To adjust the audio in a clip, click on the speaker icon in the 
thumbnail of the clip. Now you can adjust the volume of the 
clip, add an audio fade-in or fade-out, or apply ducking - 
which makes other sounds, such as music, “duck” below 
the volume of your clip. 

 
 
5.8  Adding Narration 
 
Narration is a great way to deliver information that you perhaps 
forgot to work into your video footage. To add a narration track to 
your iMovies project, follow these simple steps: 
 
Step 1 – Connect your microphone (you can also use your Mac’s 
built in microphone). Click on the microphone button (fig 5.8.1) 
in the options tab toolbar (13).  
 

 
(Fig 5.8.1 – microphone button) 
 
Step 2 – The voiceover dialog box opens. Select the correct 
microphone and test the input volume (when you speak the 
volume bars should go over the halfway mark but NOT into the 
red). 
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Step 3 – You are now ready to record. Just like when you are 
adding music to your timeline, move your playhead to the point in 
the clip at which you want your narration to begin. A countdown 
will begin – you should then start speaking when the “record” 
message appears in the preview pane.  
 
Step 4 - Click record once you’re done narrating. Your recording 
will be automatically inserted at the appropriate point along your 
clip. You can move it by dragging it.  
 
Step 5 – Finally, click play to listen to your results. If you’re happy 
with what you hear, save your project. If not, delete the audio 
track (click on it and hit delete) and start your from Step 2 again. 

 
 

5.9  Adding Titles or Credits 
 
Step 1 – Click on the title button (“T”) (Fig. 5.9.1) in the edit 
browsers toolbar (15). 
 
 

 
(Fig 5.9.1 – title button) 
 
Step 2 - Select a title style from the available list - you can take a 
sneak peek at these in the video preview pane (fig 5.9.2).  
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(Fig 5.9.2 – sneak peek) 
 
Step 3 – Enter your preferred title text into the text field in the 
preview window (12). Use the various editing options to get the 
right combination of colour, font and text size for your video. 

 
Step 4 – Once you are satisfied with your title, simply drag and 
drop it into your preferred point in your project. 
 

 
5.10 Saving Your Video 
 
iMovie has a nifty option to upload your completed videos directly 
to Youtube. Here’s how it’s done: 
 
Step 1 – Once your video is finished and ready to be viewed by 
the public at large, choose Share > Youtube. 
 
Step 2 – Enter your username and password in the pop-up 
window that appears. You can also type in the name of your 
video, keywords (tags) and a description of what your video is 
about. 
 
Step 3 – You will now be invited to select the size you want your 
video to be (small, medium or large). Then click Next followed by 
Publish.  
 
While you’re waiting for your video to upload to Youtube, you can 
start planning the sequel – in 3D, of course! 
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6.  How to Upload Your Video to Youtube 
 
The last step you need to take in order to catapult your video into 
the public eye is to put it online. Although there are many free 
video hosting websites to choose from, Youtube is by far and 
away the most popular of these and is pretty easy to work with, as 
the following steps demonstrate... 
 
Windows Movie Maker 
 
Step 1 – Visit www.youtube.com and sign in to your existing 
account. If you haven’t yet set one up, worry not - just click the 
Create Account button in the top right hand corner of the page to 
set one up (it’s free and takes only a minute or two). 
 
Step 2 – Once you’re account is up and running, uploading your 
video is a doddle. Click the Upload button that is visible from the 
top of every page (Fig 6.1). This will take you to the Video File 
Upload page.  
 

 
(Fig 6.1 – upload button) 
 
 
Step 3 – Choose the Upload video option, browse to your video 
and double-click on it to begin uploading.  
 
Step 4 – Now you should fill in the various Video information 
and privacy settings, including the video title, description and 
tags (keywords that will help people searching for those same 
words to find your video). Leave the Privacy level at Public (the 
default setting). When you are done click Save Changes. 
 
Your video will take several minutes to upload. You can close 
your internet browser if you wish – the video will be visible once it 
has been processed by Youtube.  

 
iMovies 
 
See section 5 above. 
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7.  Spreading the Word 
 
Google (the owners of Youtube) are constantly coming up with 
new and really rather brilliant ways for people to share their 
videos with the wider world. And, until they come up with a new 
‘Youtube Video Telepathy Tool’, the following options will allow 
you to reach the widest possible audience with the least amount 
of effort... 

 
7.1  How to embed a video in your website 
 
Embedding a video you have produced into your website is not 
only a good way to make sure that it is seen by as many people 
as possible, but it can also serve to liven up the look of your 
website and enrich existing content. 
 
It’s simple to do – just two moves required: 
 

i. Go to the Youtube video you want to embed and click the 
Embed button (Fig 7.1). This will reveal the embed code, 
which you should now copy (CTRL + C).  

ii. Go to your website and paste the embed code into the 
relevant section of your website and publish. 

 

    
     (Fig 7.1 – embed code) 
 

 
7.2  How to share a video on Facebook & Twitter 
 
Auto Share – perhaps the most direct way to publicize your video 
is to use Youtube’s Auto Share options. This is where you can 
choose to link your Youtube account with your Facebook and 
Twitter accounts so that, whenever you upload a new video to 
Youtube, your friends and supporters on both of these ridiculously 
popular social media websites will be automatically alerted.  
 
To do this, sign in to Youtube and go to the Video File Upload 
page (see the How to Upload Your Video to Youtube section 
above). In the Auto Share box you will see a selection of social 
media websites to which you can connect your Youtube account 
(Fig 7.2).  
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(Fig 7.2 – connect to youtube) 
 
Click Connect accounts to establish connection.  
 
Note: you will need to already have an account with the various 
social media websites in order to establish a connection with 
them from your Youtube account. 
 
Share a Video – Once you have uploaded your video and it is 
visible on Youtube, you can quickly and easily share it on your 
Facebook or Twitter accounts. Go to the video you wish to share 
and click on the Share button located directly below the video 
(Fig 7.3). 
 

    
    (Fig 7.3 – sharing) 
 
This will reveal a selection of sharing options to you. The most 
easily recognisable of these are the Email, Facebook and Twitter 
options – but you can also choose to share your video to a wide 
range of lesser know social media websites (Orkut, Buzz, 
Stumbleupon etc.) 
To share your video, click on the relevant social media button. 
(We will use Facebook here for illustrative purposes.) This will 
open up a pop-up window. First of all you will have to login to your 
account. You will be able to enter a brief introductory message 
about your video before clicking the Share button (Fig 7.4).  
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(Fig 7.4 – introductory message) 
 
Congratulations, you’ve just shot, produced, uploaded and shared 
your first online video! 

 
Your work is done here. On to the next town... 



Lights, Camera, Action!                                       The Wheel © Page 31 
 

 
Appendix I. Free Online Video Resources 

 
Online Video Hosting  
 
Youtube  (the big one – needs no introduction) - 
www.youtube.com 
 
Blip TV (for those who want a more specialized online video 
experience) - www.blip.tv 

 
Vimeo (online video hosting and social network website for 
creatively minded people and groups) – http://vimeo.com/ 
 
 
Video Editing Tutorials 
 
A good guide to editing movies in Windows Movie Maker - 
http://www.youtube.com/watch?v=JZXK68NS7gU 
 
How to edit your video in iMovies - 
http://www.youtube.com/watch?v=p_sZ4AeT8a4 
 

 
Video Slideshow Software & Tutorials 
 
Simple, free software for creating video slideshows - 
http://www.slideroll.com/videocreator.php 

 
A quick and easy tool for creating video slideshows online - 
simply upload a few digital photos, add some text and music (or a 
voiceover) and away you go! - http://www.animoto.com 
 
Video tutorial on how to create a simple video slideshow in 
Window Moviemaker - 
http://www.youtube.com/watch?v=YFwgoPWaG8o 
 
A short guide to creating a video photo-montage in Windows 
Moviemaker 2 - 
http://www.windowsmoviemakers.net/Tutorials/HowToVideoSlide
Show.aspx 
 
 
Podsafe Music (music you can use without paying royalties) 
 
http://freemusicarchive.org 
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http://www.podsafeaudio.com/ 
 
http://www.soundclick.com 
 
 
Free Editing Software (for more advanced users) 
 
CineFX: an offline editing and visual effect stool that allows you to 
work with any file format in real time on your desktop (PC & MAC) 
- http://www.cinefx.org/tools 
  
Virtualdub: a simple (but limited) PC freeware video-editing 
package - http://www.virtualdub.org 

 
HyperEngine AV: very simple “trackless” editing software for the 
Mac - http://download.cnet.com/HyperEngine-AV/3000-2646_4-
10299937.html?tag=lstpop-0-10&cdlPid=10362662 
 
 
Animation 
 
Create talking animations, by just typing a script and changing a 
few settings. Great fun! - http://www.xtranormal.com 
 

 
Video File Converter 
 
Any Video Converter: convert most video files between popular 
formats (certain file formats require full purchase of this otherwise 
free programme) - http://download.cnet.com/Any-Video-
Converter/3000-2194_4-10661456.html 
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Appendix II. Conducting a Successful Interview 
 

 
Preparation 
 

• Know what you want to get out of the interview – who’s the 
best person to talk to – what areas you want the interview 
to cover. 

 
• Know how long you want the interview to last and let your 

interviewee know too. 
 

• Give your interviewee a good idea of the sort of questions 
you’re going to ask but DON’T rehearse – you want it to 
sound spontaneous. 

 
• Remember – you are in charge. You can guide the 

interview and interrupt politely if you want to change the 
subject. If you let someone speak for a long time it will be 
boring for the viewer and will give you a nightmare editing 
job! 

 
 
Performance 
 

• Get your interviewee to say who they are and what they do: 
“I’m Mike and I live in Galway”. 

 
• Ask “open” questions which allow people to express 

themselves: questions beginning with “How, what, where or 
why”. 

 
• Keep your questions simple and short. 

 
• During the interview keep good eye contact. Look 

interested.  Nod or smile but avoid saying “cool, right, ok” 
after the answers! 

 
• Always LISTEN to what your interviewee is saying – it will 

often prompt your next question. 
 

• An interview is a conversation – it should sound engaged. 
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• Ask for an anecdote or an example of when something 
happened – this will bring the interview to life for the viewer. 

 
• If you fluff or make a big mistake, carry on recording, pause 

to compose yourself and repeat your question – you can 
delete your mistakes later using your editing software. 
Minor mistakes or ‘ums’ and ‘ahs’ are fine because they 
sound natural. 

 
    
Product 
 

• You can either use the interview in full OR select the most 
interesting 20-30 second “Clip” from it. 
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Appendix III - Online Video Glossary 
 

Common online video formats 
 
avi - (Audio Video Interleave)- A multimedia file format developed 
by Microsoft to allow synchronous audio-with-video playback. 
 
flv - Flash video file format; used to deliver video over the 
Internet. 
 
mov - A video publishing file format developed by Apple for use 
with their QuickTime video players. 
 
wmv - (Windows Media Video)- An audio and video file encoded 
for use with Windows Media Player. 
 
A - Z 
 
Autoplay - the function of a video player that starts play 
automatically. 
 
Bandwidth - the amount of information that can be sent through 
an internet connection. 
 
Buffering Video - a buffer is a temporary holding pen in a 
computer's memory for data for inputs (e.g., to software) or 
outputs (e.g., to a printer) until the process can deal with it. 
 
Captions - text that appears over a video that labels a scene, 
identifies a location or person, or narrates dialogue onscreen.  
 
Codec - (COmpressor/ DECompressor) - the technology used to 
compress an audio and/ or video file for storage or transmission 
and then decompress for playback. 
 
Conversion - the operation of changing data from one format to 
another so the output will be displayed in an appropriate manner 
for the device. 
 
Digital Camera - A camera that does not take analog video; digital 
video cameras can capture truer color and more details than 
analog cameras. Digital cameras frequently use digital video 
tapes, internal hard drives or memory cards.  
 
Embed - in online video this refers to taking video from a online 
video provider and transplanting it elsewhere on the web 
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(websites, social networking sites, etc.) through the use of HTML 
code. 
 
High Definition (HD) - technically, any video that is of higher 
resolution than standard definition. 
 
MiniDV Tape - a small format digital video cassette. 
 
Online Video - any form of digital video that is available for use 
over the internet. 
 
Playlist - a sequence defining the order in which a collection of 
video or audio files will be played.  
 
Streaming Media – this refers to internet video and/or audio clips 
that can play directly over the internet, without first having to be 
downloaded.  
 
Tripod - a three-legged stand for a camera to prevent unwanted 
movement. 
 
User-Generated Video (UGV) - video that is shot by a member of 
the audience; non-professionally produced video.  
 
Viral Videos - video content which has become popular through 
online sharing via email, forums, blogs and other web sites. 
 
Vlog (Video Blog) - a video enabled blog; users can post video 
entries which are presented in reverse chronological order.  
 
Webcast - a non-interactive, live broadcast over the web pr an 
online distribution of audio and/or video to multiple viewers or 
listeners at the same time. 
 
Zoom (optical, digital) - optical zoom relies on the camera's lens 
to bring the subject closer in the recorded video. Digital zoom 
does not use the lens, but rather enlarges a portion of the image 
digitally. 
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Appendix III – Video from DVD or Youtube 
 

Video already on Youtube 
 
What happens when you have a video on Youtube and you need 
to edit it? Youtube does not have video editing facilities itself. 
 
However, if you have a video already on Youtube, you can still 
edit the original video file with Windows Moviemaker or iMovie 
(which should already be installed on your PC/Mac. 
 
If you don't have the original video file you can download it from 
Youtube with this neat online tool: www.keepvid.com 
 
Using a video from a DVD 
 
It is well worth converting your DVD into a format that can be 
used on the Internet. Once you have done that you can post your 
video anywhere on the Internet and you can email the link to you 
supporters. 
 
To do this you need to: 
 
1. Insert the DVD into your computer's DVD drive. It may start 
playing automatically, just close the player for now. 
 
2. Next you will need to install some free software to extract the 
movie files from the DVD. Try Handbrake, you can download it 
free here: http://handbrake.fr/downloads.php 
 
3. Open Handbrake, once you have installed it (don't panic when 
you see all the options, it is easier than it looks!). 
 
4. Click on the "Source" button at the top of the screen, browse 
for the DVD and click on a folder called "Video_TS", inside you 
will find a file called "Video_TS.VOB". Click on it (there may be 
more than one, but it will be the one with the biggest file size). 
 
5. You should now select where you want to save the extracted 
video file on your computer. Click on the "browse" button next to 
the "destination" field and click select your desktop. 
 
6. Click on the "Star" button at the top of the screen - the video 
will now be extracted from the DVD an saved on your desktop. 
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7. This file can now be uploaded to www.bettertogether.ie. You 
can edit the video file with Windows Moviemaker or iMovie (which 
should already be installed on your PC/Mac. 
 
8. Upload your video here: http://www.bettertogether.ie/enter-our-
video-competition. 




